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IDG	When	collaborating	in	Word	2016,	you	must	save	the	document	to	see	changes	made	by	others	(highlighted	in	green)	and	to	share	your	changes	with	them.	The	2016	and	2019	Ribbon	is	smaller	than	in	Word	2013,	the	title	bar	is	now	solid	blue	rather	than	the	previous	white,	and	the	menu	text	(File,	Home,	Insert	and	so	on)	is	now	a	mix	of	upper-
and	lowercase	rather	than	all	caps.	The	Share	pane	shows	a	list	of	people	who	have	access	to	the	document,	with	a	note	underneath	their	name	indicating	if	they	are	currently	editing	the	document,	and	if	not,	whether	they	have	editing	or	viewing	access.Right-click	the	icon	of	anyone	currently	working	on	the	document	and	click	Open	Contact	Card;	a
screen	pops	out	with	the	various	ways	you	can	contact	them,	including	chat,	phone	and	video	via	Skype	(if	they	have	Skype)	and	email.	As	you	type,	Word	looks	through	your	address	book	and	displays	the	matches	it	finds;	click	the	person	you	want	to	invite.	To	make	the	title	bar	blue	again,	choose	the	Colorful	option	from	the	drop-down	list.	What	you
see	next	depends	on	whether	you’re	working	in	Word	2016	or	2019.If	you’re	using	Word	2016,	whenever	a	collaborator	makes	a	change,	a	small	Updates	Available	icon	appears	along	the	bottom	of	your	Word	window.	To	insert	it	somewhere	into	the	document,	move	your	cursor	to	the	spot	where	you	want	it	to	appear,	and	click	the	Insert	button	at	the
bottom	of	the	pane.	If	a	person	isn’t	in	your	address	book	—	just	type	in	their	complete	email	address.	IDG	In	Word	2019	you	can	see	other	collaborators’	edits	in	real	time,	with	a	different	colored	cursor	for	each	collaborator.	If	it	misidentifies	the	language,	though,	simply	select	the	right	one.	At	the	top	of	the	pane,	type	in	the	email	addresses	of	the
people	with	whom	you	want	to	collaborate	on	the	document,	separated	by	commas.	Word	then	uses	Microsoft’s	Bing	search	engine	to	do	a	search	on	the	word	or	phrase	and	displays	the	results	in	the	a	pane	that	appears	on	the	right	side	of	the	screen.	We've	listed	the	ones	we've	found	the	most	useful	below.	(If	you	want	to	assign	different	rights	to
different	users,	you	can	send	two	separate	emails,	or	you	can	change	any	collaborator’s	permissions	later	by	right-clicking	their	name	in	the	Share	pane.)	Type	a	message	in	the	text	box	if	you	want.	So	while	it	is	live	collaboration,	it’s	not	real-time	visibility	into	that	collaboration.	Copyright	©	2019	IDG	Communications,	Inc.	(Note	that	the	Ribbon	tabs
—	File,	Home,	Insert	and	so	on	—	stay	visible.)	IDG	Here	are	the	Ribbon	display	options.	Users	who	aren’t	signed	into	a	Microsoft	account	will	see	an	Edit	in	Browser	button;	once	they	click	that,	they	can	start	editing	in	their	browser	window.	IDG	When	you	insert	a	chart,	a	window	where	you	can	edit	the	data	pops	up.	This	is	quite	helpful	if	you	use	a
cloud	service	with	more	than	one	account,	such	as	if	you	have	one	OneDrive	account	for	personal	use	and	another	one	for	business.	Enter	or	edit	the	data,	or	else	click	the	Edit	in	Excel	button	to	open	it	up	in	Excel	and	edit	it	there.	You	can	see	what	they	do	as	they	do	it,	including	deleting,	editing	and	adding	text.	Nearly	everyone	who	uses	Office
ends	up	using	Word	at	some	point,	whether	it	be	for	writing	memos,	typing	up	agendas,	creating	reports,	crafting	business	correspondence	or	any	of	a	thousand	other	uses.Microsoft	sells	Office	under	two	models:	Individuals	and	businesses	can	pay	for	the	software	license	up	front	and	own	it	forever	(what	the	company	calls	the	“perpetual”	version	of
the	suite),	or	they	can	purchase	an	Office	365	subscription,	which	means	they	have	access	to	the	software	for	only	as	long	as	they	keep	paying	the	subscription	fee.When	you	purchase	a	perpetual	version	of	the	suite	—	say,	Office	2016	or	Office	2019	—	its	applications	will	never	get	new	features,	whereas	Office	365	apps	are	continually	updated	with
new	features.	There’s	a	useful	change	in	what	Microsoft	calls	the	backstage	area	that	appears	when	you	click	File	on	the	Ribbon:	If	you	click	Open	or	Save	As	from	the	menu	on	the	left,	you	can	see	the	cloud-based	services	you've	connected	to	your	Office	account,	such	as	SharePoint	and	OneDrive.	(Click	image	to	enlarge	it.)	When	you're	working	on	a
document	in	Word	2019	with	other	people	in	real	time,	each	person	gets	a	cursor	with	their	own	unique	color.	To	display	the	commands	underneath	the	tabs	when	they’re	hidden,	press	Ctrl-F1,	click	a	tab,	or	click	the	Ribbon	display	icon	and	select	“Show	Tabs	and	Commands.”	Show	Tabs	and	Commands:	Selecting	this	shows	both	the	tabs	and
commands.	Right-click	a	word,	or	highlight	a	group	of	words	and	right-click	them,	and	from	the	menu	that	appears,	select	Smart	Lookup.	Collaborate	liveThe	biggest	feature	launched	with	Word	2016	is	live	collaboration	that	lets	people	work	on	documents	together	from	anywhere	in	the	world	with	an	internet	connection,	a	feature	that	Google	Docs
has	long	had.	Page	2	Another	new	feature,	Smart	Lookup,	helps	you	do	research	while	you’re	working	on	a	document.	But	if	you	need	a	refresher,	see	our	Word	2010	cheat	sheet.Just	as	in	Word	2013,	the	Ribbon	in	Word	2016	and	2019	is	flatter-looking,	cleaner	and	less	cluttered	than	the	one	in	Word	2010	and	2007.	So	it’s	always	best,	when
possible,	to	have	the	strongest	connection	possible	when	collaborating.In	addition	to	seeing	each	other’s	changes	to	the	document,	you	can	communicate	with	your	collaborators	in	other	ways.	A	drop-down	menu	appears	with	these	three	options:	Auto-hide	Ribbon:	This	hides	the	entire	Ribbon,	both	the	tabs	and	commands	underneath	them.	(For	more
details,	see	“What	are	the	differences	between	Microsoft	Office	2019	and	Office	365?”)This	cheat	sheet	gets	you	up	to	speed	on	the	features	that	were	introduced	in	Word	2016	and	Word	2019,	the	perpetual-license	versions	of	Word	included	with	Office	2016	and	Office	2019,	respectively.	Just	above	the	Office	Theme	menu	is	an	Office	Background
drop-down	menu	—	here	you	can	choose	to	display	a	pattern	such	as	a	circuit	board	or	circles	and	stripes	in	the	title	bar.	IDG	Selecting	people	with	whom	to	collaborate	via	the	Share	pane.	(Click	image	to	enlarge	it.)	There’s	another	way	to	share	a	file	stored	in	a	personal	OneDrive	for	collaboration:	At	the	bottom	of	the	Share	pane,	click	“Get	a
sharing	link,”	and	from	the	screen	that	appears,	choose	“Create	an	edit	link”	if	you	want	to	create	a	link	to	the	file	that	will	allow	people	to	edit	the	file,	or	“Create	a	view-only	link”	if	you	want	to	create	a	link	that	will	allow	them	to	view	the	file	only.	(Click	image	to	enlarge	it.)	To	find	out	which	commands	live	on	which	tabs	on	the	Ribbon,	download
our	Word	2016	and	2019	Ribbon	quick	reference.	At	this	point,	they	can	view	the	document	but	not	edit	it.	Use	the	RibbonThe	Ribbon	interface	in	Word	2016	and	2019	hasn’t	changed	much	compared	to	earlier	versions.	IDG	Tell	Me	gives	advice	on	addressing	an	envelope	(or	any	other	task).	They	see	what	you	do	as	well.	If	you	or	your	organization
has	an	Office	365	subscription,	see	our	separate	Word	for	Office	365	cheat	sheet	for	coverage	of	all	the	latest	features.Most	of	the	tips	in	this	article	apply	to	both	Word	2016	and	Word	2019	for	Windows.	To	show	the	Ribbon	again,	click	at	the	top	of	Word.	(Click	image	to	enlarge	it.)	It’s	a	big	time-saver,	because	you	don’t	have	to	hunt	through	the
Ribbon	to	find	the	command	you	want.	(Click	image	to	enlarge	it.)	After	you	enter	the	addresses,	select	either	"Can	edit"	or	"Can	view"	in	the	drop-down	to	allow	collaborators	full	editing	or	read-only	privileges.	The	top	of	the	pane	shows	your	selection,	and	the	bottom	shows	the	translation.	(Click	image	to	enlarge	it.)	But	there	are	many	other
keyboard	shortcuts	to	help	you	accomplish	a	vast	array	of	tasks	in	Word	2016	and	2019.	There	are	only	two	requirements	for	collaboration	in	Word	2016:	You	must	be	logged	into	your	Microsoft	or	Office	365	account,	and	the	document	must	be	stored	in	OneDrive,	OneDrive	for	Business	or	SharePoint	Online.However,	while	Office	365	subscribers	or
anyone	using	Word	2019	or	Word	Online	can	see	the	changes	that	other	users	of	those	versions	make	to	a	shared	document	in	real	time	as	they	happen,	Word	2016	users	have	to	save	their	documents	periodically	to	see	and	share	changes.	To	get	to	them,	click	the	Ribbon	display	options	icon	at	the	top	right	of	the	screen,	just	to	the	left	of	the	icons	for
minimizing	and	maximizing	Word.	IDG	The	Ribbon	in	Word	2016	hasn’t	changed	much	from	Word	2013.	That	way,	tasks	that	you	frequently	perform	are	always	within	easy	reach.	Each	of	the	sections	in	the	Explore	tab	has	a	More	link	underneath	the	results.	When	you’re	done,	click	Share.	The	Ribbon	has	been	included	in	Office	suite	applications
since	Office	2007,	so	you’re	probably	familiar	with	how	it	works.	To	do	it,	go	to	the	Review	tab	on	the	Ribbon,	and	in	the	Language	section,	click	Translate	>	Translate	Document.	IDG	Word	2019’s	Translator	feature	in	action.	You’ve	got	other	options	for	displaying	the	Ribbon	as	well.	Still,	it	does	allow	you	to	work	with	others	on	the	same	document	at
the	same	time.To	collaborate	on	a	document,	first	open	it,	then	click	the	Share	icon	in	the	upper-right	part	of	the	screen.	Show	Tabs:	This	shows	the	tabs	but	hides	the	commands	underneath	them.	When	you	do	that,	the	chart	appears	in	your	document	with	placeholder	data,	and	a	pop-up	window	appears	that	looks	like	a	mini	Excel	spreadsheet.	The
top	pane	attempts	to	identify	the	original	language,	which	it	does	with	uncanny	accuracy.	Then	click	the	To	drop-down	to	set	the	language	you	want	to	translate	the	document	to	and	click	the	Translate	button.	If	you	haven’t	yet	saved	your	file	in	OneDrive,	OneDrive	for	Business	or	SharePoint	Online,	you’ll	be	prompted	to	do	so.	See	our	Excel	2016
and	2019	cheat	sheet	for	details	about	the	new	chart	types,	including	what	each	one	looks	like	and	what	type	of	data	it’s	best	suited	for.To	insert	any	of	the	new	chart	types	(or	any	other	chart)	in	a	document,	select	Insert	>	Chart	and	then	choose	the	type	of	chart	to	insert.	Each	location	now	displays	its	associated	email	address	underneath	it.	(Click
image	to	enlarge	it.)	Translator	can	also	translate	an	entire	document.	If	you’re	on	a	corporate	network,	you	can	click	the	address	book	on	the	right	to	search	through	your	corporate	email	address	book.	In	Office	365,	Word	has	all	those	features,	plus	several	more.	An	email	gets	sent	out	to	everyone	with	whom	you’ve	shared	the	file,	showing	a	“View
in	OneDrive”	button	that	they	can	click	to	open	the	document.	(For	help	finding	specific	commands	on	the	Ribbon,	see	our	Word	2016	and	2019	Ribbon	quick	reference.)		IDG	Using	the	Alt	key	helps	you	master	the	Ribbon	shortcuts.	Near	the	end	is	a	section	for	Word	2019	only.Share	this	story:	IT	pros,	we	hope	you’ll	pass	this	guide	on	to	your	users
to	help	them	learn	to	get	the	most	from	Word	2016	and	2019.	Click	Turn	On.	You’ll	only	have	to	do	that	once.Handy	keyboard	shortcutsUsing	keyboard	shortcuts	is	one	of	the	best	ways	to	accomplish	tasks	quickly	in	Word	2016	and	2019.	(Click	image	to	enlarge	it.)	Tackle	tasks	with	Tell	MeAlthough	live	collaboration	is	the	biggest	addition	to	Word
2016,	there	are	several	other	new	features	as	well.	To	translate	words	or	phrases,	select	them,	right-click	your	selection	and	choose	Translate	from	the	menu	that	appears.The	Translator	pane	appears.	The	Translator	pane	appears.	Each	provides	a	unique	way	to	display	data	visually.	There	are	other	minor	changes	as	well	—	for	instance,	the	old	Page
Layout	tab	is	now	called	just	Layout	—	but	the	Ribbon	still	works	in	the	same	way	and	you'll	find	most	of	the	commands	in	the	same	locations	as	in	Word	2013.	Click	the	task	you	want	to	get	instructions	on	how	to	do	it.For	example,	I	typed	“address	an	envelope”	and	chose	the	“Envelope”	result,	and	the	screen	you	use	for	addressing	envelopes
appeared.	IDG	Your	collaborators	get	an	email	message	like	this	when	you	share	a	document.	It’s	the	same	as	pressing	Ctrl-F1.	(Click	image	to	enlarge	it.)	Note	that	the	Pareto	chart	does	not	show	up	in	the	charts	list	when	you	select	Insert	>	Chart.	(In	Word	2016	this	is	called	the	Insights	pane,	while	in	Word	2019	it’s	the	Smart	Lookup	pane,	but
they	work	the	same	way.)	Microsoft	says	that	Smart	Lookup	uses	the	context	around	the	words,	not	only	the	words	themselves,	to	give	you	more	relevant	results.The	pane	is	divided	into	two	tabs	at	the	top	—	Explore	and	Define.	However,	the	image	that	you	click	will	be	the	first	image	on	the	page.In	the	web	search,	the	first	result	is	often	a	Wikipedia
entry,	followed	by	a	variety	of	other	results.	After	that,	in	the	bottom	of	the	pane	select	the	language	you	want	to	translate	to.The	translation	appears.	(Click	image	to	enlarge	it.)	Be	aware	that	how	well	real-time	collaboration	works	depends	on	the	strength	of	your	internet	connection.	In	the	"Personalize	your	copy	of	Microsoft	Office"	section,	click	the
down	arrow	next	to	Office	Theme	and	select	Dark	Gray	or	White	(or	Black)	from	the	drop-down	menu.	Logged	in	users	will	see	an	Edit	Document	menu,	from	which	they	can	choose	Edit	in	Word	to	open	the	file	in	the	client	version	of	Word,	or	Edit	in	Browser	to	work	in	the	free	web	version.The	web	version	isn’t	as	fully	featured	as	the	client	version	—
for	instance,	there	aren’t	as	many	formatting	options	and	you	can’t	insert	shapes,	take	screenshots,	use	mail	merge,	or	use	several	other	features.	A	very	useful	one	is	Tell	Me,	which	is	extremely	helpful	when	you	want	to	do	a	task	that	you	haven’t	done	before	or	have	forgotten	how	to	do.It’s	a	text	box	just	to	the	right	of	the	Ribbon	tab	labels	at	the
top	of	the	screen	with	the	words	“Tell	me	what	you	want	to	do”	in	it.	And	it	remembers	the	features	you've	previously	selected	in	the	box,	so	when	you	click	in	it,	you	first	see	a	list	of	previous	tasks	you've	searched	for.	Clicking	the	Share	button	opens	the	Share	pane	on	the	right-hand	side	of	the	screen	—	this	is	command	central	for	collaboration.
Type	in	a	task,	and	you’ll	get	a	list	of	possible	matches.	As	mentioned	above,	though,	you’ll	have	to	save	your	document	(or	click	the	Updates	Available	icon)	to	see	their	changes	or	have	them	see	yours.	For	even	more	shortcuts,	see	Microsoft's	Office	site.Useful	Word	2016	and	2019	keyboard	shortcuts	Source:	Microsoft	KEY	COMBINATION	ACTION
Document	navigation			Ctrl-Up	arrow	Move	up	one	paragraph	Ctrl-Down	arrow	Move	down	one	paragraph	Ctrl-Right	arrow	Move	right	one	word	Ctrl-Left	arrow	Move	left	one	word	Ctrl-Home	Move	to	the	top	of	the	document	Ctrl-End	Move	to	the	bottom	of	the	document	Ctrl-F	Open	the	Navigation	pane	to	search	for	text,	graphics	and	more	Ctrl-H
Open	the	Search	and	Replace	dialog	box	Ctrl-G	or	F5	Go	to	a	page,	bookmark,	footnote,	table,	comment	or	some	other	location	Alt-Ctrl-Z	Switch	among	the	last	four	places	in	the	document	you	edited	Ribbon	navigation			Alt-F	Go	to	the	File	tab	Alt-H	Go	to	the	Home	tab	Alt-N	Go	to	the	Insert	tab	Alt-G	Go	to	the	Design	tab	Alt-JT	(with	cursor	in	table)



Go	to	the	Table	Tools	Design	tab	Alt-P	Go	to	the	Layout	tab	Alt-JL	(with	cursor	in	table)	Go	to	the	Table	Tools	Layout	tab	Alt-S	Go	to	the	References	tab	Alt-M	Go	to	the	Mailings	tab	Alt-R	Go	to	the	Review	tab	Alt-W	Go	to	the	View	tab	Alt-Q	Go	to	the	Tell	Me	box	Ctrl-F1	Hide	or	display	the	Ribbon	Text	formatting			Ctrl-B	Make	text	bold	Ctrl-I	Make	text
italic	Ctrl-U	Underline	text	Ctrl-Shift-D	Double	underline	text	Ctrl-Shift-W	Underline	a	word	Ctrl-Shift-A	Make	text	all	caps	Ctrl-Shift-K	Make	text	small	caps	Shift-F3	Toggle	the	case	of	letters	among	uppercase,	lowercase	and	sentence	case	Ctrl-Shift-+	Make	text	superscript	Ctrl-=	Make	text	subscript	Ctrl-Shift->	Make	font	size	larger	Ctrl-Shift-<
Make	font	size	smaller	Ctrl-D	or	Ctrl-Shift-F	Open	the	font	dialog	box	Paragraph	formatting			Ctrl-L	Left-align	text	Ctrl-R	Right-align	text	Ctrl-E	Center-align	text	Ctrl-J	Justify	text	Ctrl-M	Indent	a	paragraph	Ctrl-Shift-M	Remove	paragraph	indentation	Ctrl-1	Change	to	single-line	spacing	Ctrl-2	Change	to	double-line	spacing	Ctrl-5	Change	to	1.5-line
spacing	Ctrl-Q	Remove	paragraph	formatting	Ctrl-Shift-S	Open	the	Apply	Styles	task	pane	Other	useful	shortcuts			Ctrl-N	Create	a	new	document	Ctrl-O	Open	a	document	Ctrl-S	Save	a	document	F12	Open	the	Save	As	dialog	box	Ctrl-W	Close	a	document	Ctrl-P	Print	a	document	Alt-Ctrl-P	Switch	to	Print	Layout	view	Alt-Ctrl-O	Switch	to	Outline	view
Alt-Ctrl-N	Switch	to	Draft	view	Alt-W,	F	Switch	to	Read	Mode	view	Alt-Ctrl-M	Insert	a	comment	Ctrl-K	Insert	a	hyperlink	Ctrl-Shift-E	Turn	revision	tracking	on	or	off	Ctrl-A	Select	everything	in	the	document	Ctrl-C	Copy	selection	to	the	clipboard	Ctrl-V	Paste	from	the	clipboard	Ctrl-X	Delete	selection	and	copy	it	to	the	clipboard	Ctrl-Z	Undo	the	last
action	Ctrl-Y	Redo	the	last	action	F1	Display	Help	F7	Run	spell	check	Alt-Ctrl-S	Split	the	document	window,	or	remove	the	split	Don't	forget	to	download	our	Word	2016	and	2019	Ribbon	quick	reference!This	story	was	originally	published	in	April	2018	and	updated	for	Word	2019	in	August	2019.	After	you	save	or	click	Updates	Available,	your
collaborators’	additions	appear	in	your	document	with	a	pale	green	overlay.	When	you	click	an	image	in	Bing	image	search,	you’re	not	sent	to	the	individual	image,	but	instead	to	a	page	full	of	the	results	of	the	Bing	image	search.	By	default,	when	you	use	Smart	Lookup,	it	shows	the	Explore	tab,	which	includes	a	Bing	image	search,	a	web	search	and
an	Explore	Wikipedia	search.	And	if	for	some	reason	that	blue	on	the	title	bar	is	too	much	color	for	you,	you	can	turn	it	white	or	gray.	To	make	the	commands	appear	again,	press	Ctrl-F1.	(In	Word	2019,	there’s	also	a	black	option.)	To	do	it,	select	File	>	Options	>	General.	You	can	let	it	auto-detect	the	original	language	or	click	the	From	drop-down	to
set	it.	Similarly,	when	I	searched	for	“gravity	waves,”	the	first	two	results	were	from	Wikipedia,	one	for	“Gravitational	wave”	and	other	for	“gravity	waves.”	In	instances	like	this	in	which	there’s	more	than	one	Wikipedia	entry,	Wikipedia	gets	its	own	section	in	the	Smart	Lookup	pane,	followed	by	web	search.	Click	it	to	see	additional	results.If	you’re
not	pleased	with	the	results	of	a	search,	I	suggest	doing	the	search	again,	because	you	might	get	different	results.	IDG	Select	“Add	a	Place”	to	add	a	new	cloud	storage	service	for	Word.	(Click	image	to	enlarge	it.)	Click	any	result	to	go	to	the	web	page	that	is	the	source	of	the	results.	And	Office	2019	added	two	more:	Funnel	and	Map	charts.	That	lets
you	talk	or	text	with	them	while	you're	working	on	the	document	together,	making	collaboration	that	much	more	effective.	If	it’s	the	first	time	you’ve	used	one	of	these	AI-driven	features,	a	screen	appears	asking	if	you	want	to	turn	Intelligent	Services	on.	When	I	typed	in	the	more	general	query	“write	an	essay,”	it	popped	up	a	link	to	Word’s
Researcher	feature	that	lets	you	do	research	from	right	within	Word,	add	sources	from	the	research	you	find,	and	then	cite	the	sources	in	the	document	properly.	On	slow	or	flaky	connections,	you	won’t	immediately	see	edits	that	other	people	make	and	they	won’t	see	yours	immediately	—	there	will	be	a	lag.	(If	you’re	concerned	about	privacy,	you’ll
need	to	weigh	whether	the	privacy	hit	is	worth	the	convenience	of	doing	research	from	right	within	the	app.)	If	you	haven’t	enabled	it,	you’ll	see	a	screen	when	you	click	Smart	Lookup	asking	you	to	turn	it	on.	Once	you	do	so,	it	will	be	turned	on	across	all	your	Office	applications.Add	new	types	of	chartsOffice	2016	debuted	six	new	types	of	charts	you
can	add	to	documents,	spreadsheets,	and	presentations:	Treemap,	Sunburst,	Waterfall,	Histogram,	Pareto,	and	Box	&	Whisker.	Then	copy	the	link,	paste	it	into	an	email	using	any	email	program,	and	send	it.When	your	recipients	receive	the	email	from	you,	they	click	a	button	or	link	to	open	the	document,	which	opens	in	Word	Online	in	a	web	browser
rather	than	in	the	Word	desktop	client.	For	example,	when	I	did	a	search	on	“coal	mining,”	the	Wikipedia	entry	was	first,	followed	by	information	from	the	World	Coal	Association.		Called	the	Translator	pane,	it’s	useful	for	those	who	need	to	work	in	multiple	languages.	IDG	Click	the	icon	of	someone	working	with	you	on	a	document	to	see	other	ways
you	can	contact	them.	Also	see	the	nifty	new	Tell	Me	feature	described	below.Just	as	in	earlier	versions	of	Word,	to	make	the	commands	underneath	the	tabs	on	the	Ribbon	go	away,	press	Ctrl-F1.	If	you	type	in	a	query	and	hover	your	mouse	over	a	result	instead	of	clicking	it,	you’ll	see	a	screen	describing	what	you	can	do	if	you	click	the	results.	You
can	even	use	them	to	navigate	the	Ribbon.	You'll	be	able	to	see	at	a	glance	which	is	which.	Word	opens	the	translated	document	in	a	new	window.Keep	in	mind	that	Translator	is	part	of	Microsoft’s	Intelligent	Services,	the	artificial	intelligence	behind	other	Office	features	including	Lookup	and	Researcher.	Word	has	always	been	the	workhorse	app	of
the	Microsoft	Office	suite.	You	can	also	copy	and	paste	any	part	of	the	translation	into	the	document	or	another	document.	To	insert	one,	select	Insert	>	Chart,	select	Histogram,	and	at	the	top	of	the	screen	that	appears,	select	the	option	to	the	right,	Pareto.Use	the	new	Translator	pane	in	Word	2019In	addition	to	two	additional	chart	types	and	true
real-time	collaboration,	Microsoft	rolled	out	a	spiffed-up	version	of	its	translation	tool.	Don’t	bother	clicking	the	definition;	it	doesn’t	link	out	to	the	web.Note	that	in	order	to	use	Smart	Lookup	in	Word	or	any	other	Office	app,	you	might	first	need	to	enable	Microsoft’s	intelligent	services	feature,	which	collects	your	search	terms	and	some	content	from
your	documents.	I	did	the	coal	mining	search	twice;	once	it	returned	one	result	from	Wikipedia,	and	another	time	it	turned	multiple	results	(one	for	coal	mining	and	another	for	“History	of	coal	mining.”).As	for	the	Define	tab,	the	result	is	simple	and	straightforward:	a	definition	of	the	word	or	term	from	the	Oxford	Dictionaries	from	Oxford	University
Press.	But	for	basic	editing,	it	works	fine.When	a	collaborator	starts	working	in	a	shared	document,	you’ll	get	a	notification	that	someone	else	is	editing	the	document.	(For	some	odd	reason,	in	some	searches	the	web	search	is	at	the	top	of	the	page,	in	other	searches	the	Wikipedia	section	is,	and	at	other	times	the	Bing	image	search	is.)	IDG	The
results	of	a	Smart	Lookup	for	gravity	waves.	For	instance,	Alt-H	takes	you	to	the	Home	tab,	and	Alt-G	takes	you	to	the	Design	tab.

Access	Google	Drive	with	a	free	Google	account	(for	personal	use)	or	Google	Workspace	account	(for	business	use).	Query	criteria	quick	reference	guide.	Below,	you'll	find	a	guide	containing	20	of	the	most	common	criteria	used	in	Access	queries.	While	these	criteria	are	all	fairly	simple,	each	one	can	help	you	carry	out	meaningful	searches	of	your
data.	If	you	find	this	guide	useful,	download	the	printable	version	so	you'll	always	have	The	Google	Docs	team	has	put	together	a	getting	started	page	here.	What	should	I	do	if	there’s	a	problem	with	my	data?	First	make	certain	that	your	notebook	data	hasn’t	been	...	As	a	precautionary	health	measure	for	our	support	specialists	in	light	of	COVID-19,
we're	operating	with	a	limited	team.	If	you	need	help	with	a	product	whose	support	you	had	trouble	reaching	over	the	phone,	consult	its	product-specific	Help	Center.	Quick	start	-	Teams	planning	guide.	15	minutes	remaining;	Step	1:	Get	your	people	together.	Assemble	a	group	of	individuals	from	staff,	educators,	and	the	educator	community	to	act
as	the	stakeholder	&	decision-making	group	for	your	Teams	deployment.	Step	2:	Prioritize	your	scenarios.	Collaboration	and	communication	are	about	people!	Apr	26,	2022	·	The	OnlyKey	user's	guide	provides	step-by-step	instructions	for	configuring	and	using	OnlyKey.	...	So	for	example	if	you	were	to	save	your	Google	password	to	slot	1a,	then	to
type	out	your	Google	password	you	would	tap	button	1	on	your	OnlyKey	for	less	than	one	second	(Slot	1a).	...	The	way	you	would	typically	set	this	up	without	OnlyKey	is	to	...	Access	Google	Sheets	with	a	free	Google	account	(for	personal	use)	or	Google	Workspace	account	(for	business	use).	Get	started	with	Microsoft	developer	tools	and	technologies.
Explore	our	samples	and	discover	the	things	you	can	build.	2)Quick	Daily	Updates	Join	our	millions	of	readers,	looking	forward	to	the	Webnovel	daily-updated	chapters.	The	Webnovel	brings	you	an	unequal	and	immersive	comic-reading	and	novel-reading	atmosphere.	3)	Active	community	That	Loves	To	Read	Webnovel	attracts	over	a	million	readers
and	authors	who	dedicate	all	passions	of	reading	and	writing.	2)Quick	Daily	Updates	Join	our	millions	of	readers,	looking	forward	to	the	Webnovel	daily-updated	chapters.	The	Webnovel	brings	you	an	unequal	and	immersive	comic-reading	and	novel-reading	atmosphere.	3)	Active	community	That	Loves	To	Read	Webnovel	attracts	over	a	million
readers	and	authors	who	dedicate	all	passions	of	reading	and	writing.	Apr	26,	2022	·	The	OnlyKey	user's	guide	provides	step-by-step	instructions	for	configuring	and	using	OnlyKey.	...	So	for	example	if	you	were	to	save	your	Google	password	to	slot	1a,	then	to	type	out	your	Google	password	you	would	tap	button	1	on	your	OnlyKey	for	less	than	one
second	(Slot	1a).	...	The	way	you	would	typically	set	this	up	without	OnlyKey	is	to	...	Google	Play,	also	branded	as	the	Google	Play	Store	and	formerly	Android	Market,	is	a	digital	distribution	service	operated	and	developed	by	Google.It	serves	as	the	official	app	store	for	certified	devices	running	on	the	Android	operating	system	and	its	derivatives	as
well	as	Chrome	OS,	allowing	users	to	browse	and	download	applications	developed	with	the	Android	software	…	Apr	13,	2021	·	Click	Download	Report.	Command	line.	Run:	lighthouse	--output	json	--output-path	Lighthouse	Viewer.	Click	Export	>	Save	as	JSON.	To	view	the	report	data:	Open	the	Lighthouse	Viewer	in	Google	Chrome.	Drag	the	JSON
file	onto	the	viewer,	or	click	anywhere	on	the	Viewer	to	open	your	file	navigator	and	select	the	file.	Quick	start	-	Teams	planning	guide.	15	minutes	remaining;	Step	1:	Get	your	people	together.	Assemble	a	group	of	individuals	from	staff,	educators,	and	the	educator	community	to	act	as	the	stakeholder	&	decision-making	group	for	your	Teams
deployment.	Step	2:	Prioritize	your	scenarios.	Collaboration	and	communication	are	about	people!	Google	Chrome	is	a	cross-platform	web	browser	developed	by	Google.It	was	first	released	in	2008	for	Microsoft	Windows,	built	with	free	software	components	from	Apple	WebKit	and	Mozilla	Firefox.	It	was	later	ported	to	Linux,	macOS,	iOS,	and
Android,	where	it	is	the	default	browser.	The	browser	is	also	the	main	component	of	Chrome	OS,	where	it	serves	as	the	platform	for	web	…	Google	Chrome	is	a	cross-platform	web	browser	developed	by	Google.It	was	first	released	in	2008	for	Microsoft	Windows,	built	with	free	software	components	from	Apple	WebKit	and	Mozilla	Firefox.	It	was	later
ported	to	Linux,	macOS,	iOS,	and	Android,	where	it	is	the	default	browser.	The	browser	is	also	the	main	component	of	Chrome	OS,	where	it	serves	as	the	platform	for	web	…	Aug	13,	2020	·	13	November	2019	•	5-minute	read.	How	to	write	a	marketing	plan	–	a	guide	for	small	business	owners.	If	you	want	to	grow	your	business	you	need	to	market	it
effectively.	And	to	do	that,	you	should	know	how	to	write	a	marketing	plan.	What	is…	Read	more	Query	criteria	quick	reference	guide.	Below,	you'll	find	a	guide	containing	20	of	the	most	common	criteria	used	in	Access	queries.	While	these	criteria	are	all	fairly	simple,	each	one	can	help	you	carry	out	meaningful	searches	of	your	data.	If	you	find	this
guide	useful,	download	the	printable	version	so	you'll	always	have	Browse	through	the	How	to's,	FAQs,	Troubleshooting,	and	Knowledge	articles	related	to	the	Druva	products.	Druva	Product	Help	is	acccessible	from	docs@druva.com.	As	a	precautionary	health	measure	for	our	support	specialists	in	light	of	COVID-19,	we're	operating	with	a	limited
team.	If	you	need	help	with	a	product	whose	support	you	had	trouble	reaching	over	the	phone,	consult	its	product-specific	Help	Center.	The	Google	Docs	team	has	put	together	a	getting	started	page	here.	What	should	I	do	if	there’s	a	problem	with	my	data?	First	make	certain	that	your	notebook	data	hasn’t	been	...	Log	miles,	create	invoices,	maintain
finances	and	cash	flow,	and	track	your	profit	and	loss	reports.	Organize	your	workday	expenses	and	manage	invoice	tracking	on	the	go	with	the	QuickBooks	Online	Accounting	app,	trusted	by	over	4.3	million	small	business	owners	worldwide.	Get	started	with	Microsoft	developer	tools	and	technologies.	Explore	our	samples	and	discover	the	things	you
can	build.
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